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OnColor Profiler — Quick Start Instructions

. Overview

OnColor Profiler Improves Numerical Correlation between Multiple
Spectrophotometers to Improve Color Communication

OnColor Profiler uses unique algorithms, combined with a specially designed set
of 32 durable and long-term stable ceramic tiles, to develop a spectrophotometer
profile on the master and target instruments. A powerful set of equations is then
calculated by Profiler to match all readings on the target instrument(s) to the
master spectrophotometer. The resulting correlation between instruments
facilitates the sharing of stored electronic standards with confidence and reduces
the chaos, confusion and rejected batches that results when instruments, even
those of the same brand, present different numerical color measurements. A
Certificate of Performance can be printed to document the results for ISO and
other quality management systems.

. FAQ’s

What is OnColor Profiler? It's a computer software program that is used to
improve the inter-instrument agreement between two or more color instruments
(spectrophotometers), thereby improving color data correlation. This improved
correlation is necessary when using stored electronic color standards and
sharing colorant files.

Don’t they already read the same? Two instruments of the same model and
the same manufacturer might start out to read the same. Two instruments of a
different model or from a different manufacturer will most likely read color
differently. With use and over time, instrument readings drift making the results
vary even more. The OnColor Profiler software correlates all these instruments
to match one designated Master instrument.

Why do I care? In this electronic age, companies and their customers
increasingly want to share data and use numerical color standards. Rather than
passing around different panels or swatches of color that change with use and
handling, it is desirable to peg a color standard to numbers and for everyone to
match those numbers. Also common is to share computer color-matching
databases. Global commerce has also escalated the need for this. With lots of
manufacturing being done in China and other off-shore locations, sending color
standards and color submits back and forth is too time-consuming. And when
the product hits the shelves in the final consumer market, the color better be
right! Even within a single company at a single location, having all color data be
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interchangeable among departments is a desirable goal. Increasingly, color
standards are stored in a database that is network-accessible by all locations and
departments. Without the color instruments reading the same, confusion and
chaos ensue when different users report different numbers.

How is it done? An instrument is “profiled” using CyberChrome’s proprietary
algorithms and a specially designed set of 32 ceramic tiles. These tiles are very
durable and stable over a long period of time—meaning the color doesn’t change
and they aren’t easily damaged. The tiles are measured under controlled
conditions on the master (or reference) instrument and then the target
instrument. A set of equations is calculated by the Profiler and is then used in
the OnColor QC or Match program to correct all readings from the target
instrument to match the master instrument.

How long does it last? We recommend profiling an instrument at least once a
year with routine checks of a green tile daily. The Instrument Performance
module of Profiler should be used monthly or quarterly to monitor the
performance of the instrument vs. the master. If the instrument is out of
specification, then it can be re-profiled to take into account drift, aging, dirt, and
yellowing of the sphere. If a re-profiled instrument does not pass the pre-set
specification, then it must be returned to the factory for service and repair.

How is CyberChrome’s product different from the competitors? Many color
computers purposely do not have access to the internet. With OnColor Profiler,
you don’t need an internet connection on the color computer. The customer
purchases the Profiling software from CyberChrome to go with their OnColor
software. The user is free to profile as many instruments as often as needed.
There is no yearly charge or subscription for each instrument to pay. OnColor
Profiler also generates an instrument certification report of agreement to the
master data which can be used on as an on-going basis to verify and document
instrument performance.

lll. Installation Instructions

1. Do NOT plug in the Profiler Hardlock USB key until later.

2. Place the OnColor Profiler CD into the CD drive. If the
installation doesn’t auto run, then use Windows Explorer to
Browse to the CD drive and then double-click on the file
“‘SETUP.EXE”.

3. Follow the prompts to begin the process. When you get to
this window below:
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2= OnColor Profiler Setup

Beqin the installation by clicking the butkon belov,

Click this button ko install OniColor Profiler software to the specified
destination direckary,

Directary:
C:\Program Filest OniCalarPrafiler), Change Directory

Q Exit Setup

For Windows XP, use the default directory of C:\Program Files\OnColor
Profiler\. For Vista or Windows 7, click the “Change Directory” button and then
at the Path: prompt type: C:\OnColor Profiler\. You will see the dialog boxes as
shown below. Click YES to create a new folder and then install the software
there.

Enter or select a destination directory,

Path:
|C:'|,OnCUIOr Prui.\}}r

Directaries:

K

[ 4F799c402ebfo2a480d5da7933fF23b8
[Cadell B
[:l Documents and Settings

([ drivers Cancel

[Dizas v

Drives:

EE -l

OnColor Profiler Setup

D] The destination direckory:
\._‘3/
ChonColor Profiler),

does not exist, Do vou want the directory to be created?

Yes Mo
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. Follow the rest of the prompts to complete the installation of the software.
. Create a shortcut icon on your desktop for Profiler by right-clicking on a

blank area on your desktop. Select NEW --> Shortcut. Then click on the
Browse button and browse to the folder that you used during the
installation. For XP it should be C:\Program Files\OnColor Profiler\.
For Vista and Win 7 it should be C:\OnColor Profiler\. In the appropriate
folder, then click on OnColorProfiler.exe as the target of the icon and then
click OK. Click NEXT and then in the next window type OnColor Profiler
as the name for this shortcut. Then click FINISH.

. Next you need to install the Hardlock drivers for the USB key for Profiler.

If you have already installed OnColor on this computer then you can skip
this step. If not, then Browse the CD using Windows Explorer and find the
file named “HLDRV32.EXE”. Double click on it to begin the installation
process. Follow the screen prompts to install the Hardlock Driver.

. Now plug in the USB hardlock for OnColor Profiler. The PC should

automatically find it and a red light should light up on the key saying it is
active. You can now double-click on the OnColor Profiler shortcut on your
desktop to run the software.

IV. Overview of Profiling Procedure

1

Measure the tile set in OnColor on the Master instrument.

Save the data as a save-set WSV file. This format must be used.
Measure the same tiles on the Target instrument and save to

A WSV file. See Section VI for detailed instructions.

Go to the Profiler program and run the Profiler Wizard using these two files.
The output is a CCF file which contains the profiled correction coefficients.
See section VIl for detailed instructions.

On the computer with the Target instrument attached, go to OnColor.
Enable the profiling option found under Options->Profile Settings.
Now you are ready to take profiled readings on the Target instrument.
See Section IX for detailed instructions.

To profile more instruments to this Master instrument, use the same Master
tile data set, but measure the tiles and save a different file for each Target
instrument.

OnColor Profiler Quick Start Guide 6




IV. Ambient Conditions for Profiling

Controlling the ambient room conditions used when profiling and making
measurements is extremely important in obtaining the optimum results. The
temperature of the room should be 21 +/- 1° C and 65 +/- 2% relative humidity.
The Profiler ceramic tile set should be allowed to equilibrate for at least one hour
at these conditions before making measurements on the tiles.

V. Generating the Data Set for the Tiles in OnColor

OnColor QC or OnColor Match software is used to measure the ceramic tile set
and generate the save-set used in Profiler. Using the option under Trial->
Measure from File is helpful for consistently naming the tiles and avoiding
repetitive input of tile names. Before beginning, be sure to condition the tiles to
ambient room conditions as recommended above and clean any that have dirt,
dust, or fingerprints on them according to the recommended procedure. Also be
sure that the white calibration tile for the instrument is clean. Then, calibrate the
instrument for the instrument settings that you want to profile (for example, SCI +
SCE). If the instrument is capable of doing SCI + SCE simultaneously, then be
sure to calibrate for that condition. Select aperture sizes for both instruments that
match closest to the normal usage level. Use the following procedure to
measure the tiles for both the Master instrument and the Target instrument.
You will need one save-set WSV file for each instrument.

L. In OnColor, Open a New

document by clicking on

. Std l Options | Std Defaults | Trial Defaults |
or File> New and then

. Mame: A0 characters max

select an OnColor WSV file. -1 ULTRAWHITE
2. Go to File>Page Setup to
Alternate MNarne: 40 characters max

check the company name. [John Smith
ThlS WI” al_Jtomatlca”_y be System: 20 characters max
read later in the Profiler | H123456 -
SOftware- lf y0U need to Motes: 80 characters max
change it, do so now. The MBR Profile Set #123

default for the Company
Name is saved in the PRP
file, but each WSV file can Date/Time:
have a different company
name.

3. Click on Standard -
Measure or Standard
—>Average and take the
prescribed number of I

readings on the first tile
which is T-1 ULTRA WHITE. o] cance Al Help
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4. After entering the name for the Standard which is the first tile in the tile
set, you can also enter the default information for:
The Operator — This goes in the Alternate Name: field
The Instrument Serial Number — This goes in the System: field
The Color Tile Set Number — This goes in the Notes: field
You will have the option to change this data when you Profile the
Instrument.

5. To measure the remaining 31 tiles in the Profiler ceramic tile set, click on
Trial> Measure from File.

6. In the File Containing Trial Names dialog box, browse to the folder that
contains the file called “PROFILER TILE NAMES.TXT” or other file that
contains the names of the

remaining 31 tiles. Open this OnColor [%|
file. This should be in the o
same folder as your Profiler ? There are 31 Names in the Trial Names File
executable. =2 Are you sure you wish to measure 31 Trials?
7. The following dialog box is
shown: Yes Mo
8. Click on Yes.
9. If you wish to average measurements, click on Yes (recommended if you
are using an 8mm or smaller aperture) in the following dialog box:
OnColor
‘33) Do you wish to Average Measurements?
Yes No l
X
10.The name for the next tile is automatically Waiting for Average Meas. 1... A=
read from the file. Click OK to begin the —
measurement sequence. If you are Position Sample:
averaging measurements, the dialog box T2 BLACK
shown below will appear. Click OK to read
the tile. Then re-position the tile and click
on OK to read the next spot. Repeat this statistics sfter () Meas.
procedure until you have read 4 spots on L a b
the tile. Click on Done when you are Mean
finished and the average of the 4 readings Std. Dew
will be displayed. If you did not select erlance
averaging, then clicking OK will initiate the RUEI
single measurement and you will proceed Maximum
to step 11. Minirmum

11.The name for the next tile in the series is
read from the file. Position the next tile at | ‘
the measuring port and click on OK to
begin measurement procedure. oK |
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12.Repeat steps 10 & 11 until all tiles have been read.

13.Finally, save this file by clicking on File->Save As or this icon on the
toolbar. Select a folder to save the data and then name the file according
to the instrument model and serial number.

14.1f you have single status instrument (one that measures only SCI or SCE
at a time and not simultaneously), then you will need to repeat this
procedure to generate a data-set for each condition.

VI. OnColor Profiler Wizard

You will need at least two save-set files (WSV) containing the measurements on
the 32 Profiler tiles according to the above procedure before running Profiler—
one file for the Master instrument and one for the Target instrument. The output
file of Profiler is called a correlated coefficients file (*.CCF). The coefficients file
saves the correlation data for both SCI and SCE in the same file. Therefore
depending on the instruments that you are profiling, you may need anywhere
between 2 to 4 save-sets of data. See the table below:

Master Type Target Type # of WSV files # of CCF files
multi-status multi-status 2 WSV’s 1 CCF
multi-status 1-status 3WSV’s 1 CCF

1-status multi-status 3WSV’s 1 CCF
1-status 1-status 4 \WSV'’s 1 CCF

Examples of a multi—status instrument are the Konica Minolta CM-3600d, CM-
2600d, CM-2500d, X-Rite XTH, Color Eye i7 and i5. Single status instruments
include the Datacolor SF 600, SF 300, SF 350, Color Eye 7000 and 7000A, Color
Eye 3000, Hunter LabScan, Mini Scan, Color Quest, and UltraScan. If the
instrument reads both SCI and SCE conditions at the same time, then itis a
multi-status instrument and OnColor will save the tile data for both conditions in
one file. If the instrument reads only one condition at a time, then it is a single-
status instrument and OnColor saves only one condition in a file.

Once you have the requisite number of files, launch the OnColor
Profiler program by double-clicking on this icon on your desktop:

OnColor Profiler provides three Wizards to guide you through the process of:
e Profiling an instrument
e Checking the performance of an instrument (Section XIllII)
e Converting legacy data (Section 1X)
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To profile an instrument follow the steps below. The operations of the other two
wizards are detailed later in this manual.

1. Open the Profiler software. To enter tolerances for each individual tile
and the average of all tiles, click on Tolerances. This dialog box allows
you to adjust the tolerances according to your specifications. Typical
tolerances would range from 0.5 to 1.0 for each individual tile and 0.20 to
0.40 for the average of all tiles.

Single Tile DE Limitis —>[{ 00 =

&

. - =

Average Tile DE Limit —>!o,25
=

Accept Cancel

2. To run the profiling wizard, click on Wizards - Profile. The following
dialog box explains the procedure:

= Profile Wizard %]

You have selected the Profile Wizard. This Wizard will
guide you through the process of profiling a Target
spectrophotometer to a Master spectrophotometer. To
proceed. you will need to have already measured the set
of 32 ceramic tiles in OnColor and saved the data into a
save-set (WSY file) for both the Master and the Target
instruments. You also need to know the path or location
on your computer for these 2 W3V files.

Cancel T oK
CGancel | [OoK

3. Click OK to continue. The following dialog is displayed where you select
the WSV file for the Master instrument.
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w, Profile Wizard - Enter Master Instrument Data

The next step is to select the Save Set (WSY file) that
contains the data on the tile set from the MASTER
INSTRUMENT. The Master instrument is the
spectrophotometer that will be used as the reference
instrument and all other spectrophotometers will be
profiled to read like the Master. In the next window,
browse to the location on your computer and select this
Save Set.

P I [}OK

4. Browse to the location on your computer to select the WSV file of the
readings on the 32 tiles for the Master instrument. Highlight the name of
this file and click “Open”.

5. If you selected a multi-status instrument (one that does both SCI & SCE),
the following dialog will appear. If you selected a single status
instrument, then the gloss is fixed and you will go to step 7.

w. Profile Geometry Selector Wizard

In the next window. select the Instrument status for the
specular component, either SCI (gloss included) or SCE
(gloss excluded). If you want to generate a Profile for
both SCI and SCE. then you will need to run this Wizard
twicelonce for each status. Both statuses can be stored
within the same Profile. If using a 45/0 instrument. then
you only have one status for the specular component and
only need to run the Profile one time. You cannot profile
a sphere instrument to a 45/0 instrument or vice versa.

Cancel
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w, Specular Component @@@

6. After clicking OK, select the
gloss setting on your
instrument, either SCI or SCE Select Component
and click OK :

(¢ :5Cl - Specular Component INCLUDED:

" SCE - Specular Component EXCLUDED

OK |

7. The following dialog is displayed.

w Profile Wizard - Enter Target Instrument Data

The next step is to select the Save Set (WSY file) that
contains the data on the tile set from the TARGET
INSTRUMENT. The Target instrument is the
spectrophotometer that you want to profile to make it read

§ like the Master. In the next window. browse to the location
on your computer and s?lect this Save Set.

~0

Cancel

8. Browse to the location on your computer to select the WSV file of the
readings on the 32 tiles for the Target instrument. Highlight the name of
this file and click “Open”.

9. After opening the file, the following window is displayed:
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w. Profile Header Wizard @

In the next window. input the information for the Color Tile
Set Serial Number. the Instrument Serial Number. and the
Operator for both the Master and the Target
spectrophotometers. [f this information was previously
input into the Save Set (WSY file) when the tile set was
measured. then it will appear here and can be edited if
needed. This information is saved in the Profile and
printed on all certificates.

P I T

............................................

10.0n the next window, enter the information for the serial number of the
color tile set, the instrument serial number and operator. The company
name is taken from the name stored in OnColor when the tiles were read.
To change this, go back to OnColor and open the save-set WSV file for
the Master and Target instruments. Go to File->Page Setup and change
the company name there. Then re-save the WSV files. The instrument
type and status are automatically recorded in OnColor and cannot be
changed. After entering the data, click OK to continue.

w, Profiling Status Q@

Master Instrument Target Instrument
Type: Macbeth 7000 Type: Macbeth 2180
Status: CRIPS Status: CRIEL
Date: 6/3/2008 11:45:32 &AM Date: 6/3/2008 11:45:32 &AM
Company: CyberChrome, Inc. Company: CyberChrome, Inc.
Color Tile Set Number: I Color Tile Set Number: I
Instrument Serial Number: || Instrument Serial Number: |
Operator: | Operator: |
Print Cancel oK

11.The raw data is displayed for each tile with a progress bar at the top while
the profiled correction coefficients are being calculated. The resultis a
CCF file which contains the equations on how to correct the target
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instrument to match the master. This CCF file is then used in OnColor to
correct all subsequent readings.

12. After reviewing the data, save the resulting CCF file on your computer.
We suggest that the name of this file should include the name and serial
number of both the Master and Target instruments. Choose a
nomenclature that is unambiguous, so that you know which instruments
are profiled in this CCF file.

w. Profile Wizard - Save Coefficients

The profile coefficients have been calculated! The results
are displayed in the window. The next step is to Save the
profile coefficients in a file to be used and applied in
OnColor. You will need to choose a name for this
Instrument Profile and a location or folder on your
computer to save it. We recommend that you include the
name and possibly S/N of the Master and Target
instruments as part of the name.

1
e T

13.The final step in the process is to print out the certificate and optionally
save it as a text file:

w. Profile Wizard - Print Certificate
&

Cancel | L OK

The final step in this Wizard is to print the Certificate of
Instrument Performance. Print as many copies as you
need by selecting the number of copies in the Print dialog
box. If you do not want to print the results, click on
Cancel.
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14.The results are displayed in the format shown below. The raw data
comparing the individual tile readings is shown aside of the profiled or
corrected readings. The average DE for all 32 tiles is displayed before
and after profiling. Any readings that are highlighted in red have failed
the tolerances entered in step 1 above in this section.

™
n ; - Raw Data Corrected Data

Sample Name DL* Da* Dhb* DE DL* Da* Db* DE
Average DE 011 o008  o1e| o024  oos| o008 o007 015
B-1 LT GRAY 002 012 -00d] o015  ooo[  ooof  ooof oo
B-2 DEEP RED 016 o016 033] o040 o002 008 o013 020
B-5 WHITE 018  ooo] -028] 034 o00[ ooo] o000 000
B-6 MID GREY 00a] -007] 014 018 ooo] o000 ooof oo
B-7 DEEP GREY oos| 011 -oos| o013 ooo] 001 ooof oo
B-8 BLACK 004  -012[ 004 013 ooo] o000  ooof 000
B-9 YELLOW 002 019 020 o028 0o  on| -00s] 014
B-10 DEEP GREEN ooo] o005 -013] o014 004 o024 -om| 024
B-11 MID-BLUE 011  -oo8] -oos] o014 oos] oo ors] o022
B-12 DEEP ORANGE-RED 013]  -031 o023] o040 -om| -036[ -oos] 038
B-13 CYAN 007]  ooo] 019l o020 oos] o11] 004 014
B-14 DEEP BLUE 007 001  -015] o017 010 ooz 008 014
B-15 MID-ORANGE 013 o013 031 036
B-16 DEEP ROSE PINK 019 010  003] o022 o004 017 -005] 018
P-1 GREY 20% 003 012 -0o8]  oa1s] 011 004 o004 o012
P2 GREY 85% o] 007 -026] 030 o004 004  o00[ 006
P-4 GREY 40% oo1] 006 o1o] o012 oozl o006 ooof 006
P GREY 80% -018]  -0os] 024 031 -007] 004 002 008
P-8 LIGHT YELLOW 01a8] 004 036 o040] -00s] o007 007 o
P-9 LIGHT PINK 007] 015 -om|  o17[  -oo0s] 007 o003] 009
P-12 LIGHT CYAN -008] 007 014 o017 006 o014 003 o016
P-15 GREY 50% oos| 010 -om| 015 o003] o001  -003] 0.4
P-16 GREY 33% 013]  -007] 012 o019 oos] o000 00| 008
5-2 DEEPVIOLET 00 013 o003 017 o004 010 o004 o1
5-4 RED [ oso T oea T oss s3]  o10]  oo0s|  o018] 020
56 YELLOW GREEN 007  -004  -018]  o20[  oos] o019 003 oz
5-6 PURPLE 011 004  oos] o013 oozl 017 o10] o020
5-7 YELLOW-ORANGE 012 019 -oos| o023  oos| o008 003 01
S-8 GREENISH YELLOW n2z| 008 o019 040

5-9 RED-ORANGE 032] 013 o] o040 on|  -008] -002] 015
5-11 DARK BLUE o1zl oo 016 o020 o010 o005 o0z 012
5-13 MID-GREEN 0oz o006 -019] o020 om| o018 o004 018

VII. Using Profiling in OnColor

The Correlation Coefficients file (*.CCF) that was generated in the Profiler Wizard
is used in OnColor to correct the raw reflectance data coming from the target
instrument to closely match the master instrument.
1. Be sure that a copy of the *.CCF file generated above is copied onto the
local computer that runs the target instrument. While the file can be
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located anywhere that the computer has access to, it is easiest if it resides
in the OnColor folder or a sub-folder of OnColor.

2. To activate the use of Instrument Profiling in OnColor, go to Options—>
Profile Settings and then click on the Browse button to locate the Profile
that you want to apply to the target instrument. It will be a CCF file.

3. Click on the check box to Enable Profiling Correction. This must be
checked in order for the corrections to be applied in OnColor. Click Apply
to recall the file. See the screen below:

Profile Settings

C:\Program Files\CyberChrome\OnColor\PROFILES\Myrons Profile

4. To see the details of this profile file, click on the Details tab, where you
can print a report to attach to data printouts of the profiling specifics.

Profile Settings

16




5. Click OK to exit the dialog box and proceed using OnColor with Profiling
enabled. Any profiled measurement will have a “P” in the second position
of the status code; for example, CPIIMM. See Section Xl for a listing of
the Status Codes.

VIII. Instrument Performance Wizard

The Instrument Performance Wizard is used to monitor the performance of an
instrument over time and tell whether it conforms to a reference instrument. This
tool can tell you whether your instrument is drifting over time due to dirt,

yellowing of the sphere, usage, etc. A log of these results can be used to show
instrument conformance for ISO or Quality Management programs. A baseline of
readings must be established. Usually a Target instrument is compared to a
Master instrument and therefore the baseline is the data on the tile set from the
Master instrument.

An alternate way to use this would be to establish a baseline on the Target
instrument (preferably after it has been serviced and certified by the
manufacturer) and then compare on-going readings to this baseline. This will tell
you if the instrument is drifting over time, but it won’t tell you if it still conforms to
a Master.

Either the set of 32 Profiler Tiles or a shortened set of ceramic tiles can be used.
Other types of samples such as paint, plastics, or textiles are allowed but it
should be understood that these samples may drift over time and not provide the
stability that ceramic tiles do. This method is sometimes used to conduct
customer/supplier audits where a set of product color standards is used rather
than the Profiler tile set.

The user designates a tolerance for the readings on each individual tile as well
as the overall average. If the Instrument Performance shows any readings out of
tolerance, further checks need to be done. First, clean the offending tile and re-
measure it. If it still fails, then this instrument needs to be re-profiled to the
Master. If the instrument cannot be brought within the specification after re-
profiling, then it must be serviced or re-calibrated by the manufacturer. This can
either be done on-site or by return to the factory depending on the manufacturer.

Follow these steps to run the Instrument Performance Wizard.
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In OnColor Profiler, click on Wizards - Instrument Performance. A
message is displayed that you have selected this Wizard. Click on OK to
continue.

The following dialog is displayed: Click OK to continue.

w| Profile Wizard - Enter Master Instrument Data @

The first step is to select the Save Set that contains the
MASTER Data

Cancel

In the next dialog box, select the file that contains the reference data for
the Master instrument. This data can either be on the set of 32 tiles or
another collection of samples.

The next step is to select the data for the Target instrument on the same
collection of

samples. The
two save-sets
must match in The nest step is to select the Save Set that contains the
terms of q TARGET Data

number of
samples and
their order!

Cancel

In the next dialog box, select the file that contains the current data for the
Target instrument.

After opening the file, the following window is displayed:

Enter the information for the serial number of the color tile set, the
instrument serial number and operator. You can use the Tab key to move
from box to box. The company name is taken from the name stored in
OnColor when the tiles were read. To change this, go back to OnColor
and open the save-set WSV file for the Master and Target instruments.
Go to File>Page Setup and change the company name there. Then re-
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save the WSV files. The instrument type and status are automatically
recorded in OnColor and cannot be changed. After entering the data, click

OK to continue.

w. Profiling Status

Master Instrument
Type: Macbeth 7000

Status: CRIPSS
Date:

Company:

Color Tile Set Number:  [MBR 4

Instrument Serial Number: [H123456

Operator: |MDL

Print

Target Instrument
Type: Minolta CM-500

Status: CRIEMM
Date:

Company:

CEX

Color Tile Set Number: I MER 4

Instrument Serial Number: [10021187

Operator:  |EFE|

Cancel

oK

Master instrument and the following report is given:

OnColor Profiler Quick Start Guide
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Sample Name DL* Da* Db* DE

B1 Light Gey 018 -0.09 0.10 0.23

B-2 DEEP RED 0.11 -0.14 018 0.26

B-5 WHITE 0.07 -0.06 0.04 0.10

B-6 MID GREY 0.38 0.09 0.21 0.44

B-7 DEEP GREY 0.36 0.04 019 0.41

B-8 BLACK 0.38 0.00 0.22 0.44
B-9 YELLOWY

B-10 DEEP GREEN 0.27 -0.39 0.37 0.60

B-11 MID-BLUE 0.29 -0.15 0.05 0.33

B-12 DEEP ORANGE-RED 0.29 0.04 0.50 0.58

B-13 CYAN 0.25 -0.47 -0.20 0.57

B-14 DEEP BLUE 0.25 0.03 0.01 0.25

B-16 MID-ORANGE [ o3[ oes| 070l 10|
B-16 DEEP ROSE PINK 0.11 0.26 -0.03 0.29

P-1 GREY 20% 0.23 0.04 019 0.31

P-2 GREY 85% 0.04 -0.05 013 0.15

P-4 GREY 40% 0.08 0.05 0.20 0.22

P-5 GREY 80% 0.07 -0.08 0.07 012
P-8 LIGHT YELLOW 019 -0.11 053 0.58
P-9 LIGHT PINK 0.09 0.28 0.08 0.30
P-12 LIGHT CYAN 0.20 -0.37 0.06 0.43
P-15 GREY 50% 0.24 -0.20 0.16 0.35
P-16 GREY 33% 0.28 -0.03 0.23 0.36
5-2 DEEP VIOLET 0.25 -0.23 -0.09 0.35
S-4RED 0.38 0.44 0.73 0.93
S-5 YELLOW GREEN ,

5-6 PURPLE
-7 YELLOW-ORANGE , 13
5-8 GREENISH YELLOW |

5-9 RED-ORANGE 0.11 0.62 0.29 0.69
5-11 DARK BLUE 0.32 -0.14 -0.05 0.35
5-13 MID-GREEN 0.36 -0.62 0.45 0.85
Average [ [ [ T us

The red highlighted areas indicate data points that failed the tolerance,
including the overall average. In this case, the instrument needed to be
profiled back to the Master.

9. The final step is to print a certificate of instrument performance.
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IX. Legacy Data Conversion Wizard

The Legacy Data Conversion Wizard provides a tool for you to take a set of color
data that was measured on one instrument and convert those readings to a new
instrument. For example, this option might be used when you have stored color
standards that were measured years ago on an older spectrophotometer. Some
or many of those standards may no longer physically exist, or if they do, they
might be faded, scratched, or dirty. You may still need to match those stored
readings, but now you would like to have them relative to a new instrument that
you bought. The Legacy Data Conversion Wizard helps you accomplish this.

The legacy data needs to be brought into OnColor format, if it is not already in
that format. OnColor provides several options to do this. Several other file
formats can be directly imported into OnColor. Or you can use the feature to
import the data from a TXT file. Consult the OnColor documentation or contact
your CyberChrome applications engineer on how to do this.

In order to use this Wizard, you will need your legacy data in an OnColor WSV
file and you will also need the CCF file from the Profiling Wizard that profiles the
old instrument to the new one. The CCF file is used to apply the new profile to
the old data to convert it relative to the new instrument.

Follow these steps to run the Legacy Data Conversion Wizard.
1. In OnColor Profiler, click on Wizards - Legacy Conversion. The following
message is displayed. Click on OK to continue.

w, | egacy Wizard @

You have selected the Legacy Data Wizard. This Wizard
will guide you through the process of applying an
instrument profile to a database of Legacy Data to
convert it to a new Master instrument. To proceed you
will need the legacy data in the form of a save-set (WSVY
file) from the Target instrument; and the Instrument Profile
or CCF file that corrects the Target instrument to match
the Master instrument. You also need to know the path or
location on your computer for these 2 files.

Cancel
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2.

The next screen is displayed:

w Profile Wizard - Enter Target Instrument Data

The first step is to select the Save Set that contains the
Legacy Data from the Target instrument in OnColor WSV
format. This is the data file that will be converted.

0

P l OKh

3.

In the next dialog box, browse on your computer to select the OnColor
WSV file that contains the old legacy data that needs to be converted.
The data must be in WSV format at this point.

The next screen directs you to open the CCF file that contains the profile
of the old instrument (Target) to the new one (Master). Browse on your
computer to find and open the appropriate CCF file.

. After clicking OK to open this file, the CCF file is applied to the data and it
is converted. The following dialog is displayed:

w Profile Wizard -‘Save Data

!

The File has been converted. The next step is to Save
the converted file and name it appropriately.

Yl

Cancel
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6. Click OK and then enter a name for this new file. It will be an OnColor
WSV file. The data is now ready to be recalled in OnColor. Once in this
format, you can copy the data to a Database of Standards or manipulate it
in many ways.

X. How to Handle and Care for your Ceramic Tile Set

A. Introduction
For many years, technologists who need to measure and control color have used
optical glasses and ceramic tiles as color transfer standards. Color standards
fabricated from vitreous materials are practical because of their durability,
maintainability, and long-term stability.
Whenever a precision optical component is cleaned, its critical surface may be
damaged. If consistency and long-term stability are important, proper cleaning
procedures must be employed. Storing and handling color standards as
described below reduces the frequency of cleaning, preserves the standards,
and maintains their stability. With proper care vitreous color standards should
remain stable and in good working condition for many years.

B. Inspection
To inspect a glass or ceramic optical standard for the presence of lint or dust,
illuminate the surface with a diffuse light source. (Reflected northern daylight
works well for this. An illuminated magnifier (ring lamp) can also be useful.) Hold
the tile by the edges of the Delrin® holder, and view the optical surface at several
angles to minimize surface glare.

C. Contamination
Two types of soiling alter the reflectance characteristics of precision optical
standards:
1. Dust, dirt, skin oils, grease, and films of aerosols (from unfiltered air or
commercial cleaners) alter the reflectance properties of vitreous color standards.
These changes usually can be reversed using appropriate cleaning technigues.
Careful storage and handling procedures minimize contamination and the need
for cleaning.
2. Exposure to abrasives, chemical vapors, skin acids or liquid acids, liquid
alkalis, high temperatures, and some types of radiation can induce irreversible
color changes. If the optical surface of the standard has not been damaged
physically and the damage to the glass or glazed surface is not severe, the
standard can usually be re-calibrated and returned to use.

D. Physical Damage
Ceramic and glass optical standards (including CERAM® tiles) are vulnerable to
etching by acidic and alkaline agueous solutions. Exposure of ceramic glazes to
dilute acids can cause leaching of metallic oxide, sulfide, or selenide pigments.
The optical surfaces can be etched permanently following exposure to dilute
acids that contain even small concentrations of dissolved metallic fluorides.
(Hydrofluoric acid has long been used to etch glass and fused silica.) Immersion
of vitreous transfer standards in strongly alkaline solutions that contain dissolved
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metallic phosphates (e.g., Na3PO4) or hydroxides (e.g., NaOH) may cause
etching.
Exposure to organic solvents may damage the printed labels and the Delrin®
plastic holders in which our standards are mounted.
Glass and ceramic optical standards are vulnerable to scratching by abrasives,
including kitchen/bathroom cleansers. Any scratching or abrasion of the glazed
or polished optical surface causes permanent damage and ruins the standard. To
avoid this, keep your work area free from grit and dirt such as household dust or
cement dust, and use only the materials and procedures recommended below for
cleaning. Never clean your standards using ordinary paper, cloth, or commercial
cleaners.

E. Handling
Always wear lint-free gloves when you handle glass and ceramic color standards
during spectroscopic measurements. We recommend using high-quality woven
cotton film gloves or cotton or nylon cloth inspector's gloves. After several hours
of use, launder cloth gloves to remove soiling and contamination by perspiration
and skin oils.
Whenever you use liquid cleaning agents, wear disposable powder-free
polyethylene or nitrile lab gloves. For impermeability to chemical solvents we
recommend disposable nitrile gloves. Wash your gloved hands with soap and
warm water to remove traces of powder or other contamination. Rinse with clean
water and dry the gloved hands with a clean, lint-free towel. Discard disposable
gloves after a single use.

F. Storage
We jacket individual glass and ceramic color transfer standards in lint-free optical
component bags. We package sets of color standards in dust- and light-tight
boxes fabricated from high-impact plastic. (Descriptions and photographs of the
standards are published on the Mt. Baker Research. website
<www.mrbakerresearch.com>.
After a measurement, return each color standard to its container. After a work
session, insert each standard in its protective jacket. Store the closed boxes in a
controlled environment that is clean, dark, and dry. For long-term storage we
recommend using locked cabinets housed inside the lab, office, or warehouse. If
the storage environment is dusty or subject to airborne contaminants, seal each
boxed set of standards inside a 3-mil laboratory grade zip-loc polyethylene bag.

G. Cleaning
For routine dust removal use a clean camel's hair or anti-static brush and/or non-
flammable compressed fluorocarbon propellant. If you store and handle
standards properly, frequent treatment with liquid cleaners should not be
necessary.
When a glass or ceramic standard becomes contaminated with skin oil,
immediately clean it with isopropyl alcohol. Always wear disposable lab gloves
during this procedure since isopropyl alcohol dissolves skin oils and cosmetic
creams causing contamination of the optical surface. Because isopropyl alcohol
is irritating and toxic, wear eye protection and avoid prolonged exposure to its
vapors.
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Clean the soiled standard with a fresh absorbent, non-abrasive wiper moistened
with a few drops of isopropyl alcohol. Wipe the optical surface gently in a single
path using a circular motion. (Do not use a scrubbing motion. Any abrasive grit
adhering to the wiper may permanently scratch the optical surface.) Remove
excess alcohol using a fresh, dry wiper and inspect the standard. If you observe
smears, streaks, or fingerprints, clean the standard with liquid detergent as
described below. Discard each wiper after a single use.
Remove water spots with a fresh non-abrasive wiper moistened with one drop of
dilute distilled white vinegar. Immediately rinse the cleaned surface with distilled
water. Remove excess moisture with a fresh wiper, and proceed immediately to
the isopropyl alcohol cleaning procedure that is described above. Never soak
optical standards in dilute vinegar (or another acid) that contains dissolved
metallic fluorides, and avoid prolonged exposure of your standards to skin acid or
acidic solutions.
Remove fingerprints, heavy soiling, or grease stains with a fresh non-abrasive
wiper moistened with unscented lab detergent. Use a gentle scrubbing action,
but avoid scratching the optical surface if the soiling contains abrasive material.
For heavy soiling use several treatments — always with fresh wipers. Rinse the
cleaned surface with distilled water. Remove excess moisture with a fresh wiper,
and proceed immediately to the isopropyl alcohol cleaning procedure as
described above.

H. Long-term Stability
Precision optical standards are fabricated from glass and ceramic materials,
which have long been noted for durability and chemical stability. As these color
standards age, their optical properties do not undergo spontaneous change. As
noted above, temporary (reversible) changes in color and appearance may result
from surface contamination. Permanent changes may result from physical
damage to the optical surface (etching or scratching) or from chemical changes
following exposure to chemically reactive liquids or vapors or certain types of
radiation.
In practical terms the long-term stability of vitreous color standards is mainly
influenced by the work environment and the procedures used to store, handle,
and clean the standards. In adverse work environments gradual changes in color
and appearance may be unavoidable. We encourage you to standardize your
maintenance procedures based on the guidelines presented here.
For critical applications we recommend that you purchase color standards that
have been calibrated with certification at a commercial metrology laboratory.
The contract calibration services offered by the National Institutes of Standards
and Technology and the National Research Council of Canada are very
expensive. In North America Profiler Technologies L.L.C. and Mt. Baker
Research L.L.C. offer high quality, traceable calibration services. If very long-
term stability of color and appearance is important, we recommend that you
engage a suitable metrology laboratory to re-calibrate your standards on an
annual basis.
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I. Temperature Stability
The colorants used in glass and ceramic transfer standards include stable
inorganic chemicals such as metallic oxides, sulfides, and selenides. Colored
vitreous materials may exhibit reversible changes in color that accompany
changes in temperature. This characteristic, which is termed thermochromism, is
significant in color metrology.
Malkin, et al. reported the thermochromic behavior of BCRA Series Il tiles, which
are manufactured by CERAM Technology Ltd. (See: F. Malkin, J.A. Larkin, J.F.
Verrill, and R.H. Wardman, “The BCRA-NPL Ceramic Colour Standards, Series |
— Master spectral reflectance and thermochromism data,” Journal of the Society
of Dyers and Colorists, 113, 84 — 94 (1997).)
According to Malkin, et al. red, orange, and yellow tiles exhibit greater sensitivity
to temperature than other colors. Intensely colored tiles exhibit greater sensitivity
than pastels or white and grey tiles. Consult the original reference for quantitative
details, and remember that standard glazes are used in all ceramic color
standards including CERAM tiles. (See: R.A. Eppler and M. Obstler,
“‘Understanding Glazes,” The American Ceramic Society, Westerville, Ohio,
2005, ISBN 1-57498-222-2, <www.ceramics.org>).
More recently, Dr. David Wyble (Rochester Institute of Technology) measured
the temperature sensitivity of the ceramic color standards introduced during 2007
by Mt. Baker Research L.L.C. and Profiler Technologies L.L.C. Dr. Wyble
performed these new measurements with a custom instrument that operated in
the (0°/45°) bi-directional geometry. His measurements correlate well with the
results published by Malkin, et al. for CERAM tiles. We look forward to the
detailed report of this important new study.

J. Appendix—Recommended Chemicals & Supplies
Isopropyl alcohol: Use spectroscopic grade or the best available medical grade
available at your pharmacy. (Note: Commercial laboratory supply firms offer
spectroscopic grade solvents in Teflon® squirt bottles. While spectroscopic grade
isopropyl alcohol is preferred, it is very expensive.)
Distilled water, de-ionized water, or filtered tap water: Available in plastic
containers at supermarkets and pharmacies.
Mild liquid soap or detergent solution: Avoid commercial cleaning agents that
contain scents, acids, or strong alkalis. Unscented liquid hospital soap is okay.
Prepare a working solution by dissolving 1 teaspoon of liquid soap in 1 quart of
distilled water. Store the solution in a laboratory grade plastic squirt bottle.
Fluorocarbon propellant: We recommend using canned 1,1,1,2-tetrafluoroethane,
such as SPI Easy Duster® (Structure Probe, Inc.
<www.2spi.com/spihome.html>). Although 1,1,1,2-tetrafluoroethane is non-
flammable and minimally toxic, avoid chronic exposure to the vapors. (Visit the
Structure Probe, Inc. website to access a material safety data sheet.) Don’t
shake the propellant container. Do use a ventilated hood or work in a well-
ventilated lab, and avoid flammable propellant products, including difluoroethane.
Dilute acetic acid: Dilute distilled white vinegar with distilled water to 1% acetic
acid concentration. (Note the restrictions listed in the cleaning procedure.)
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Camel's-hair or anti-static brush: We recommend StaticWisk® brushes
(Kinetronics Corporation <www.kinetronics.com>). When your brush becomes
contaminated with dust or skin oil, wash it gently in accord with the
manufacturer's instructions.

Dust- and lint-free, absorbent, non-abrasive lens tissues and wipers: We
recommend Pec*Pads® (Photographic Solutions, Inc. <www.photosol.com> and
SPI-CleanWipes Polyester Wipers® (Structure Probe, Inc.
<www.2spi.com/spihome.html>). After you open a new package, store the
unused wipers in a sealed 3-mil laboratory grade polyethylene zip-loc bag.
Lint-free cotton and nylon inspector's gloves. (For sources visit the following
websites: <www.criticaltool.com>, <www.galeton.com>, or <vwrlabshop.com>.)

OnColor Profiler Quick Start Guide 27


http://www.2spi.com/spihome.html

Xl. Instrument Status Codes

The following table of Instrument Status Codes is helpful in deciphering the 6-

digit code that is used to describe the instrument set-up conditions at the time of

measurement. These codes are also printed on the Certificate of Performance

so that you can tell the instrument settings used for this Profile.

Instrument Status Codes

Large Area of View mask (LAV)
Medium Area of View mask (MAV)
Small Area of View mask (SAV)

Very Small Area of View mask (VSAV)
Petri Dish Accessory (CM-3500d only)

Position Letter Meaning
1 B 100% Line Calibration
C Ceramic Calibration
H Hitch Calibration
K Keyboard Input
L Low lllumination Calibration
X Not Calibrated
2 R % Reflectance
T % Transmission
P Profiled % Reflectance
3 I Specular Component Included (Gloss Included or SCI)
E Specular Component Excluded (Gloss Excluded or SCE)
B Both SCI and SCE
4 A Extra Filter
E UV Component Excluded
F UV Component Excluded w/420nm Cutoff
G UV Component Excluded w/400nm Cutoff
I UV Component Included
P Partial UV
Q Partial UV w/420nm Cutoff
R Partial UV w/400nm Cutoff
5 X Extra Large Aperture lens setting (XAV)
L Large Aperture lens setting (LAV)
M Medium Aperture lens setting (MAV)
S Small Aperture lens setting (SAV)
V Very Small Aperture lens setting (VSAV)
U Ultra Small Aperture lens setting (USAV)
6 X Extra Large area of View Mask (XAV)
L
M
S
\%
P
U

Ultra small Area of View mask (UAV)
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